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Trademarks:

Beckman®, Biomek® 3000 ( Beckman Coulter Inc.); Roche®, LightCycler® 480 ( Roche
Group); DyNAmo™ ( Finnzyme Oy); SYBR® (Molecular Probes Inc.); Invitrogen™,
Platinum® ( Invitrogen Corp.), MicroAmp® ( Applied Biosystems); Microsoft® |
Windows® 7 (Microsoft Corp.). All other trademarks are the sole property of their
respective owners.

Copyright Notice:

No part of this manual may be reproduced or transmitted in any form or by any means,
electronic or mechanical, for any purpose, without prior written permission of Arise
Biotech Corp.

Notice:
This product only provides pipetting functionality. Arise Biotech Corp. does not
guarantee the performance and results of the assay and reagent.
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1 Safety Precautions

1. Safety Precautions

10.

11.
12.
13.

14.

15.

16.

17.

It is recommended to carefully read this operating manual prior to operating the
EzMate 401/601 Automated Pipetting System. To ensure safe operation and avoid
problems that might arise while using the EzMate 401/601 Automated Pipetting
System, it is essential to observe the following points. Do not use the machinein a
potentially explosive environment or with potentially explosive chemicals.

Install the machine in location free of excessive dust.

Avoid placing the machine in direct sunlight.

Place the machine on a flat and sturdy surface, capable of withstanding the
weight.

The machine should be in an indoor temperature of 15 ~ 30°C, relative humidity
40 ~85%.

Keep the side and rear of the machine at least 10cm from the wall or other
machine.

Make sure the power source conforms to the required power supply specifications.
To avoid electric shock, make sure the machine is plugged into a grounded
electrical outlet.

Do not allow water or any foreign objects in the various openings of the machine.
Switch off the machine prior to cleaning or performing service on the machine,
such as replacing the fuses.

Repairs should be carried out by authorized service personnel only.

Open the lid only when the XY Z axes is not moving.

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the biological and chemical substances before you use and
dispose.

For research use only. When using the machine in diagnostic procedures with an
in vitro diagnostic medical device, the IVD Directive should be applied
separately.

Users should be informed on the correct usage and user protection measures when
handling hazardous substances. Use protective gloves when handling infectious
substances (such as human samples or reagents)..

It is recommended to wear a mask and goggle to prevent users from inhaling
hazardous vapors from the machine.

Follow the manufacturer’s safety instructions when operating the machine.
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. Electric Shock Warning: Please be aware of electric shock.

Pinching Hand Warning L abel: Please be aware of pinching hands.

A Warning: Please be aware of the dangers.



2 Product Introduction

2. Product Introduction

EzMate™ 401/601 is an automatic, high-precision pipetting system specially designed for
low-volume PCR/gPCR sample preparation. Its design concept is to replace tedious and
repetitive pipetting of PCR/QPCR sample preparation traditionally performed by
hand-held manual pipettor, and at the same time keep the operation of a manual pipettor.
EzMate™ 401/601 will save your time and money through reliable results. You will be
assured to “Work Smart” with the EzMate™ 401/601.

2.1 Features

Easy to Use

- Interchangable 4-position (EzMate 401) or 6-position (EzMate 601) 96/384-well
plate(SBS)/tip rack worktable and 2 reagent areas.

- Software: EzStarter™ can be mastered in one hour. No technician required.

- Built-in PCR/QPCR setup protocols can be easily modified and transferred via
USB memory stick.

- 1/8-channel, 50upl or 200ul, Automated Pipetting Module (APM) can be
exchanged without tools.

Easy to Afford

- Themost affordable Automated Pipetting System available in the market.

- EZTip™ robotic tips compatible with Beckman® Biomek® 3000 model.

- CoolBlock™ keeps sensitive reagents/samples for more than 60 minutes at 7 °C.

- Saving reagent costs by reducing human errors and using more dense plates.

Easy to Service

- Mail-in calibration and service of Automated Pipetting Module (APM).

- Online PC software update.

- Compact and light-weight.

Accurate and Precise

- Automated Pipetting Module (APM) is calibrated by 1SO-8655 standards.

- Excdlent results for gPCR standard curve and replicates.

- Better Precision than manual pipetting.
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2.2 Hardware Overview

The EzMate 401/601 Automated Pipetting System includes a base platform (“APS”),
an Automated Pipetting Module (APM), a control Notebook computer and other
adapters for labwares. The base platform (APS) is composed of the X/Y/Z axes
motion mechanism, a power supply and some control circuit boards (PCBs) which

are in charge of motion control, communication and APM control. More information
is described below.

2.2.1 Outlook

Automated Pipetting Module(APM)

t — ]

| |

AcrylicLid — |

|
etk
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l E— | ‘ Notebook Computer
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Disposable Used Tip Tray

2 X Reagent Areas

T Door M agnet

Door Detection Switch 4-position (EzMate™ 401) or 6-position
(EzMate™ 601) SBS Worktable

Figure 1. Front View



2 Product Introduction

Name Function
Automated APM is the core engine for accurate and precise pipetting. APM can
Pipetting be exchanged without tools. All APMs are calibrated using | SO-8655
Module(APM) |standards. The specifications of APM are shown in section 2.2.3.
AcrylicLid Used for the protection of dust and emergency stop. The movement

of XYZ axis will stop, once the Acrylic Lid is open. To ensure the
Door Detection Switch is activated, close the front acrylic door to the
door magnet and shut it tightly.

2 X Reagent Areas

R1/R2 Area: accommodates the R1 adapter for 2 x 4 1.5ml/2ml micro
tubes, and the R2 adapter for 6 x 2ml free standing tubes and 1 x 5mi
bottle, and reservoir adapter for 80ml reservair.

CoolBlock™ adapters are available for Regent Areas.

EzMate40l: |A/B/C Area: accommodates the elevated and CoolBlock™ adapters|
4-position SBS |for PCR plates/stripes/1.5ml tube, and deep well adapter for deep
Worktable well plate.
C/D Area: accommodates the tip racks.
EzMate601: |A/B/C/ID/IE Area: accommodates the elevated and CoolBlock™
6-position SBS |adapters for PCR plates/stripes/1.5ml tube, and deep well adapter for
Worktable deep well plate.
C/D/E/F Areac accommodates the tip racks.
Disposable Used |Capacity > 400 tips
Tip Tray
Door Magnet  |Lock the acrylic Lid into its place.

Door Detection

The operation of XYZ axis will stop, once the door opening is

Switch detected.
Notebook Used in running the control software: EzStarter. Microsoft®
Computer Windows® 7 operating system or higher version is included.

Note:

SBS represents the Society for Biomolecular Screening (SBS). The SBS worktable and
its adapters accommodate the SBS recommended |abwares.
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RS-232 Port
Air Vents <
USB Port

Power Cable

Product Label - — Connector
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.N' _h i Power Switch
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Figure 2. Rear View

Name Function

Power Cable |Power cable socket and fuse drawer.
Connector

Power Switch |Power On/Off switch. I: ON, O: Off.

USB Port For connection with Notebook Computer.

RS-232 Port  |For connection with computers that do not have USB ports.

Air Vents For air ventilation.

Product Label |Indicates the model name, serial number, power specification, and
other important information

2.2.2 Control Notebook Computer

EzMate 401/601 is controlled by a Notebook Computer. The specifications of the
Notebook Computer can be upgraded to a higher performance model in the future.
For detailed specifications and operation of the Notebook Computer., please read
its User Guide, Quick Guide and product label carefully. The Microsoft® operation
software English Windows® 7 (or other higher version) and EzMate 401/601
control software: EzStarter is pre-installed in the Notebook Compuiter.

Note:

To avoid any computer virus or software conflict, it is highly recommended
not to connect the Notebook Computer with Internet and not to install any
application software in this Notebook Compuiter.

The calibration information of XY Z axes and labware adaptersis stored in the
EzStarter control software. To switch the Notebook Computer between
different EzMate 401/601 units will lose the original calibration information
and affect the positioning of adapters.

6



2 Product Introduction

The methods and log files of EzStarter can be transferred easily by an USB
storage device, such as a memory stick and hard drive, or multi-card reader that
accepts Secure Digital (SD), MultiMediaCard (MMC), and Memory Stick (MYS).

Minimal PC specifications required to run EzStarter are as followed:
® 1 gigahertz (GHz) or faster 32/64-bit (x86) processor

® 1 gigabyte (GB) RAM (32/64-bit)

® 16 GB available hard disk space (32/64-bit)

® DirectX 9 graphics device with WDDM 1.0 or higher driver

2.2.3 Automated Pipetting Module (APM)

Four different interchangeable APM models, including single and 8-channel for
two volume ranges. 50ul and 200ul. Their product specifications are shown below.
The function of APM can be seen in Figure 3. 1- and 8-channel APM.

Volume Range Increment | Accuracy Precision
Catalog No. Channels
(1) (ul) (Rel.+) |(Re.CVE)
275-ezar01-00 1 1~50 0.5 7.0-1.0% | 7.5-0.4%
275-ezar02-00 1 10~ 200 1 3-0.8% | 1-0.15%
275-ezar03-00 8 1~ 50 0.5 7.0-1.0% | 7.5-0.4%
275-ezar04-00 8 10~ 200 1 3-0.8% | 1-0.15%

Indication Light

Fixation Bracket /' > ‘ ‘
/ Volume Engrave
Tip Fitting i e

J
v»:n:t::c::

Figure 3. 1- and 8-channel APM
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2.2.4 Labware Adapters

EzMate 401/601 supplies various adapters to accommodate different labwares.
The list below shows the available adapters and labwares. To expand EzMate
401/601’s flexibility, more new adapters will be designed in the future. Please take
sometimeto visit our web site at www.arisebio.com.tw for the latest adapters.

The worktable has indented lines and symbols to display the 4-position (EzMate
401, Area A/B/C/D) or 6-positon (EzMate 601, Area A/B/C/D/E/F) and Reagent
Area R1/R2. Inside the Areas, there are fixation holes for the positioning of
adapters. Insert the pins of the adapters to these fixation holes to accurately
position the adapters.

CoolBlock™ can maintain the sensitive samples/reagents at 7°C for more than 60
minutes. The typical CoolBlock™ ( refer Figure 4.) includes 2 parts. the Core and
the Insulation Housing. To use CoolBlock™, store it in -20°C freezer for more
than 3 hours before use. The Insulation Housing will maintain the low temperature
of Core and position itself in the worktable.

Insulation Housing

Figure 4. CoolBlock™ 96 Adapter


http://www.arisebio.com.tw/

2 Product Introduction

Catalog no. Description Applied Labware Worktable Adapter
Area
275-ezar21-00 | 96 tipsrack adapter | @ 96x50pl tips rack C,D(401):
® 96x200ul tipsrack | C,D,E,F(601)
275-ezar22-00 | Elevated 96-well ® 96-well PCR plates
PCRplate adapter | ¢ gingle 0.2ml PCR | A,B,C(401);
tube A,B,C,D,E(601)
® 0.2ml PCR dtrips
275-ezar23-00 | Elevated 384-well ©® 384-well PCR
A,B,C(401);
PCR plate adapter plates
A,B,C,D,E(601)
275-ezar24-00 | Deep well plate ©® 96-well deep-well
sPWElP CPWEL! A B.C(40):
adapter plates
A,B,C,D,E(601)
275-ezar26-00 | 4 x 2 1.5ml tubes ® 1.5ml micro tubes
adapter R1,R2 3
275-ezar27-00 | 3x 2 2 ml storage ® 2m| storage tubes
tubesand 1 x 5ml ® 5mi storage tubes R1,R2
bottle adapter
275-ezar30-00 | CoolBlock™ 96 ® 96-well PCR plates
adapter for 96-well | ¢ gingle 0.2ml PCR | A,B,C(40);
PCR plates tube A,B,C,D,E(601)
® 0.2ml PCR strips
275-ezar31-00 | CoolBlock™ 384 -
oolbloc ©® 384-well PCR A,B,C(401);
adapter for 384-well plates
A,B,C,D,E(601)
PCR plates
adapter for 4 x 2 R1,R2
1.5ml tubes
adapter for SX22 | g gl storage tubes RLR2
ml storage tubes and
1 x 5ml bottle
275-ezar37-00 | CoolBlock™ 20 i
00 ocC ® 1.5ml micro tubes A,B,C(401), o ___?:-1!
adapter for 20-well e

1.5ml tubes

©® 2ml storage tubes

A,B,C,D,E(601)
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Catalogno. | Description Applied Labware Worktable Adapter
Area
275-ezar40-00 | 20-well 1.5ml ® 1.5ml microtubes | A,B,C(401); -
adapter ® 2ml storagetubes | A B,C,D,E(601) -
275-ezar47-00 | Reservoir adapter ® 30ml reservoir
with 1 x 80ml R1,R2
reservoir
275-ezar49-00 | 20 x 80ml reservoir | @ 80ml reservoir
R1,R2
275-ezar66-00 | HLA typing adapter | ¢ i
60/72 well Terasaki A.B,C(401):
for 60/72 well Tray
A,B,C,D,E(601)
275-ezar67-00 | HLA typing adapter | @ 96 well Terasaki
for 96 well Tray AB,C(40D)
A,B,C,D,E(601)
275-ezar68-00 | 0.5ml tube adapter ° -
0.5ml micro tubes A B,C(401):
for 20 well adapter
A,B,C,D,E(601)
275-ezar72-00 | 3 x 15ml reservoirs | @ 15ml reservoir i[
adapter R1,R2 o
L
reservoir x 9 pcs R1,R2 '(77"'"! "
275-ezar74-00 | 3 x 8-strip tubes ® 0.2ml PCR 8- strip
adapter tubes R1,R2 'J:ﬁ
275-ezar75-00 | 96-well conical ® 96-well PCR plates
bottom adapter ® Single 0.2ml PCR | A,B,C(401);

tube
® 0.2ml PCR strips

A,B,C,D,E(601)

10




2 Product Introduction

Catalog no. Description Applied Labware Worktable Adapter

Area

275-ezar76-00 | Elevated ELISA / ® 6~96-well

cell culture adapter ELISA/Cell culture | AB:CA0L: 18
plates ABCDEG0D | | B
275-ezar78-00 | Illumina48-well °® i X o
llumina  48-well A.B.C(401): =N
plate adapter plate

A,B,C,D,E(601) Lw

2.2.5 CoolBlock™ Operation and Performance

® Operation

Prior to usage, store the CoolBlock™ adapters in the freezer at -20°C for at least 3
hours. After removing the Cool Block ™ adapter from the freezer to a normal room
temperature environment, it will be required to stay on the bench for 5 minutes.
Users can then put the labwares into the CoolBlock™ adapter, and maintain the
samples/reagents inside the labwares under 7°C over 1 hour.

Caution!
Once the CoolBloc adapter is removed from the freezer, do not
immediately put the tubesinto it. Otherwise, the samplesin the tubes will
freeze.

kTM

& Warning! Do not autoclave the CoolBlock ™.

A Warning! Do not storethe CoolBlock™ under -20°C.

® Pearformance

All CoolBlock™ adapters can maintain its temperature under 7°C over 1 hour
after being removed from -20°C freezer. The temperature profile of CoolBlock™
96 and CoolBlock™ R1 can be seen in the figure 5 and figure 6.

11
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Figure 5. The performance of CoolBlock™ 96 Figure 6.The performance of CoolBlock™ R1

2.2.6 DisposableUsed Tip Tray

The standard Disposable Used Tip Tray contains more than 400 x 200pl tips. The
Disposable Used Tip Tray can be easily removed for used tips dumping and
disinfection. To prevent contamination to samples or reagents, a disposable Tray
Cover can be placed on top of the Disposable Used Tip Tray.

2.3 Software Overview

EzStarter is a powerful, graphic control software specialy designed for the
application of PCR/gPCR setup. For the ease of operation, al the procedures and
labwares required for PCR/QPCR setup are considered during the product design
phase. Notebook Computer and Microsoft® Windows® 7 operating system are
required for the operation of EzStarter.

12



3 Getting Sarted

3. Getting Sarted

3.1 Unpacking

EzMate 401/601 packaging is custom-made to protect the machine during

transportation and unpacking. These materials are recyclable and

environment-friendly. Please follow the procedures below and refer Figure 7 to

unpack the instrument.

Cut off the PET strapping bands of carton.

Remove the Top Cover.

Remove the Outer and Inner Side Walls by pulling it upward.

Remove the Accessory Box Partition, Accessory Box.

Remove the Top PE foam.

Remove the EzMate 401/601 from the Bottom PE foam and place it on a flat

surface.

7. Open the lid and remove the Fixation Bracket (Red, Figure 8), used in
positioning the Y and Z axes during transportation, by unscrewing 7 screws.
Screw the 7 screws back to the original holes.

o a0k~ wbdrE

Note:

1. Important! Please remove the Fixation Bracket before operating EzMate
401/601. Failing to remove the Fixation Bracket before operation might
damagetheY and Z axes.

2. Itisrecommended to save the packing materials for future usage.

13
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Top Cover — @
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|
e
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= |
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e l
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Accessory Box Partition @>

Inner Side Walls /

Bottom Cover and Pallet

Figure 7. Unpacking of EzM ate 401/601
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3 Getting Sarted

Figure 8. Removal the Fixation Bracket

3.2Content List

Open the EzMate 401/601 Automated Pipetting System package and check that you
have the following items:

1. EzMate 401/601 with one 1/8-channel, 2. Operation manual x 1
50ul/200ul APM attached.

3. Electric fuse (3.15A) x 1 4. AC power cord (US/EU/UK plug) x 1

5. Warranty card x 1 6. USB cablex 1

7. Notebook Computer x 1 ( or higher 8. EzStarter control software DVD x 1
performance model) with mouse (including USB driver and others)

9. Disposable Used Tip Tray X 5 10. R1 Reagent Adapter x 1 (Option)

11. R2 Reagent Adapter x 1 (Option) 12. 96 well Plate Adapter (Option)

13. 384-well Plate Adapter (Option) 14. Tip Rack Adapter (Option)

15. Other optional items

If there are any missing, damaged, or incorrect items, please contact your distributor
or sales representatives immediately. Other purchased optional items, such as
adapters and accessories, might be included in the accessory boxes.

15
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3.3 Instrument Installation

Before running EzMate 401/601, users are required to complete and confirm the
simple hardware installations below. If these hardware installations are not
implemented correctly, the APM module might not pick up the tips or liquid
correctly and might collide with the labwares. This might damage the APM.

3.3.1 APM Installation and Removal

The interchangeable 4 Automated Pipetting Modules (APM) provide the
flexibility and convenience. The standard EzMate 401/601 package is installed
with one single channel 50ul/200ul APM. For different liquid handling
applications, users can order additional APMs. The remova and installation of
APM are ssmple and do not require any hand tools.

Please follow the steps below to remove the APM before exchanging a new one.
1. Power off EzMate 401/601 and Notebook Computer.

2. Unscrew the APM Fixation Screw (Please see Figure 9).

3. Hold the central section of APM around the metal Fixation Bracket.

4. Push the APM outward to your body.

5. Disconnect the Control Cable on top of the APM.

Docking Bracket (with 2 fixation pinsin front and 2 fixation pinsin rear)

Control Cable

Fixation Bracket

0
et
e

¢ Fixation Screw
Pull/Insert APM Direction

Figure 9. APM Installation and Removal

16



3 Getting Sarted

Follow these stepsto install the APM:

1. Hold the central section of APM around the metal Fixation Bracket.

2. Slide and push the APM Fixation Bracket into the metal Docking Bracket of
Z-axis. The holes of APM Fixation Bracket must connect with the one fixation
pin in the front and two fixation pins in the rear of Docking Bracket of Z-axis
firmly. Loosening the connection of these two brackets will affect the accuracy
and precision.

3. Firmly screw in the fixation.

4. Connect the Control Cable at the top of the Z-axis to the APM. The connector
of the Control Cableis directional.

3.3.2 Adaptersinstallation

There are currently 9 Adapters available for EzMate 401/601. Refer to section
2.2.4 for the applied labware products of these Adapters. Additiona adapters will
be available soon.

The worktable of EzMate 401 is divided into 6 Areas (A, B, C, D, R1, R2)
through engraved lines and marks, while EzMate 601 has 8 Areas (A, B, C, D, E,
F, R1, R2). These are positioning holes for the Adapter installation in these 6
Areas. To install the Adapters, insert the pins under the Adapters (96 tip rack
adapter, R1 adapter and R2 adapter, etc.) or 4 rods around the Adapters (Elevated
96-well PCR plate adapter and Elevated 384well PCR plate adapter) to the
positioning holes of these 6 Areas. The Adapters for R1 and R2 Area are
directional, while the Adaptersfor A, B, C, and D are non-directional.

Note:
To ensure the correct positioning, no labware products should be placed on
the worktable without the support of the Adapters.

3.3.3 DisposableUsed Tip Tray Installation

A Disposable Used Tip Tray is placed on the left-hand side hollow section of the
worktable. This Disposable Used Tip Tray can be removed by pulling it upward
with the right and left-hand side of the tray. The hollow section of the worktable
will position the Disposable Used Tip Tray correctly and prevent it from moving.
The slot on the Tray Cover is used to prevent the sample or reagent from spilling
when the g ected tips touch the bottom of the tray.
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Disposable Used Tip Tray

Figure 10. Used Tip Tray Installation and Removal

3.34 Computer Connection

The standard package includes a Notebook Computer with pre-installed

Microsoft® Windows® 7 operating system or higher version and EzStarter. Follow

these steps to connect the Notebook Computer and EzMate 401/601.

1. Connect the Type B connector of the USB cable to the USB socket in the rear
of the EzMate 401/601.

2. Connect the Type A connector of the USB cable to any USB socket of
Notebook Compuiter.

Note:
An USB driver is pre-installed in the Windows® 7 operating system.

18



3 Getting Sarted

3.4 Power On the Instrument

After theinstalling the EzMate 401/601, place the labware products, such astip rack,
plates, and tubes ( with samples/reagents) on the Adapters.

Proceed with the following steps to turn on the instrument.

1
2.

Power on the Notebook Computer.

Power on EzMate 401/601. The green indication light will be turn on and the
Notebook Computer will automatically recognize the USB driver of the EzMate
401/601. The XY Z axes and APM will perform a calibration routine.

Double click the EzStarter @ on the Windows® desktop to start the control

software.

The initial screen (such as the one below) will appear and ask for account and
password entry.

Key in the account name and password to login EzStarter. To access EzStarter,
users can typein “User” as account name without entering a password.

The Administrator’s account name is “Admin” and the password is “0000”. For
security purpose, users should change the Administrator password in the
System/Account menu after initial log-in.

ﬁﬂi SC

WEICOME to EzStarter

Verzion
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Note:
1. Account ID and password are case-sensitive.

2. If the Administrator password is lost, please call the authorized
distributor for help.

3. If the lid is open when the EzMate 401/601 is on, calibration routine
will not be performed and a warning beep sound will continue.

3.5 Starting EzStarter

Once users are in EzStarter, follow these steps to check the connection between the
machine (APS) and APM.
1. A message window: “Apply APS and APM communication?”” will appear. Press

“OK” to perform the connection. “Done” will appear and press “OK” to
continue.

2. Press “Cancel” to run EzStarter without controlling EzMate 401/601. The status
bar in the lower-left corner of Worktab will display “System Offline”.

To run EzStarter, please refer to chapter 4 to 6 for more information and advanced
settings.

3.6 Exiting and Shutting down

When users are done with the EzMate 401/601, exit EzStarter and shut down
EzMate 401/601.

To exit EzStarter, select either Exit in the File menu or click “X” at the top right
corner of the EzStarter worktab.

To shut down EzMate 401/601, switch off the Power Switch at the rear of EzZMate
401/601. The green indication light of APM will be turned off at the same time.
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4. Software

This chapter provides thorough information on the EzStarter. All elements shown in the
protocol file ( file format: *.aps ) screen, such as the Menus, the Toolbar, the graphic
Worktable section for labware selection, the Protocol section for writing a series of
commands, the Property section for the information of APM and pipetting data and the
Run section, are covered in this chapter.

4.1 Menu Map of EzStarter

EzStarter includes 7 menu: File, Edit, Protocol, Labware, Report, System, and Help,
which are located at the top of the protocol file screen.

File Edit Protocol Labware Report System Help

Each menus include their own function and sub-menus. The structure is shown in

Figure 11. Menu Map.

Menu

File Edit Protocol || Labware || Report System Help
— New — Delete —{ Run —{ Tube — Protocol | [ Buzzer — How Dol
1 Open | Duplicate | [| Pause | Plate —Log —| COM — About
| Save — Exchange | [ Stop —1Tip —JAPS Connection
] Save As —| Add — Prerun —| Robot Test
— Page Setup |H Insert — Account
— Print —| Reset | Software
— Preview — Sample Info. — Service Mode
 Exit

Figure1l. Menu Map
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4.2 File

The File Menu gives access to a number of file related functions which can be
accessed viathe Toolbar.

wafeﬁ\‘_ﬂit Protgcol Lak
New CTRL+ N
Open CTRL+ O

4 Save CTRL+S

Ca

Ve AS..

Gy

Page Setup

Print CTRL+ P
Previe
Exit

New (Ctrl + N)
This option allows the users to create a new protocol file ( file format: *.aps).

Open (Ctrl + O)
This option opens an existing protocol file that can be modified to create a new
protocol file, or used asit is.

Save (Ctrl +9)
This option saves the current setup to a protocol file. All available parameters are
saved.

Save As
This option saves the current setup to a new protocol file. Users can modify an
existing protocol and save as a new file name.

Page Setup
This option alows users to configure various options (size, margins, page orientation)
related for print out.

Print (Ctrl + P)
This option alows users to print the current protocol file’s Protocol Report which
includes the selected labwares, commands, property, and so on.
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Preview

This option allows users to preview the printing.

Exit

This option allows users to close the software.

4.3 Edit

The Edit Menu alows users to create and modify the running protocol commands.
All functions in the Edit Menu can aso be accessed by right clicking the mouse

button on the command tab.

Ddete

File

7E—d|‘t~j\ Protocol Labware Rep
Delete E
Duplicate CTRL+D
Exchange CTRL+E
Add
Insert CTRL+1
Reset
SampleInfo. CTRL+S

This option allows users to remove a sel ected command.

Duplicate (Ctrl + D)

This option allows users to copy a selected command.

Exchange (Ctrl + E)

This option allows users to exchange a selected command.

Add

This option allows users to add a new command.

Insert (Ctrl +1)

This option allows users to insert a new command.

Reset

This option allows users to empty the source and destination setting of a selected

command.
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Sample Information (Ctrl + S)

Clicking Total View in the Sample Information window will display all the selected
wells. Users can key in each wells’ information in Sample Information window, and
print the sample information under the Protocol Report (4.6.1).

v [l feem I

I I 100 Buflar bt M7

B Tt |dNTP @mM)

it 01 | Poser 1 (1004

ie [ET | Prosar 2{70uM)

i [F1 [Tag

B 61 | DHA

9 B9 | oo Oiptios! G544l Rssction Pt

E A2 | Momlee® Opial 5 Wal Aaation Plan

Wy B2 Memde® Optns) S el Raction Pt

iB [£2 | Mol ® Oplsl 5-Wal Ruaction Flain

[ D2 Memde® Optms) 56 el Rasctian Pt

B (B2 | Moo ® Opbcal 55 Wal uaciior Plan

£ P ] m——

B G2 | Moo ® Oipkcal 55 Wl Faschion Plan

B B eSOt S el Rectian, Pt

g A3 fewg:® Ophcal 55 Wall Faaction Pleim

e .

[7) Tt i I S ||

4.4 Protocol

The Protocol Menu allows the operation of current protocol files. Some functionsin
the Protocol Menu can also be accessed via the Toolbar.

File Edit | Protocol | Labware |

O ¥ Run F5

_ Sien1\ornd W Pause
& Stop
= Prerun F10

Run (F5)
This option allows users to run a protocol.

Pause
This option allows users to pause the protocol.
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Stop
This option allows users to abort the protocol.

Prerun (F10)
This option allows users to simulate the running process.

4.5 L abware

There are three sub-categories in the Labware menu: Tube, Plate and Tip. EzStarter
is pre-installed with the labware database for commonly used disposable robot tips,
storage tubes/reagent vessels and 1 x 8 microstrips /96-well/384-well microplates.

File Edit Protocol | Labware | Report
By [ Tube
Plate
R1 Tip

45.1 Enablethe Tubesin worktable

Under the Labware Tube window, check the “Enabled” box for the selected tube
and the boxes of the adapters to be used with the tube, then click the “Save”
button to save the settings. Close the Labware Tube window to go back to the
EzStarter window.

T g - ™ : B
= = 1. .
Bma - Lamicy Mo LaamEEe [N Myt Ll Todama Erahl * Fodatk e 1
Eaie  SCT-IS8-C K] LD o R -i5-C . i Fal g D i
b ACT 0 SR A0 T AT 8 x At i e
5 ks Fill ol mie e
- Ppprmert DS T W% e ol s L Sl Ha L . e F el iy blieudd]
labars COIZENAEN (1% o Himcirichs Tol ] i} LRI Eeuied A il
o s T Pam e Frmairalpier
labaca T (ST Sag- 5 Tobs Sy 0 2l ] 1] Fawvcui. Pemse [Swikd woie
Ridghie S0GR0IS Farer-ibih Bu P, 3 al syl ] a fxm G
HTRE T Famn Hiere Inbe 1 %l PR Liselnd FF O i ] Ti 1 ok Liged
LS ke Lonat [oplasize

45.2 EnablethePlatesin worktable

Please refer to Section 4.5.1 to enable the plates in the worktable, and also check
the workable areas for the plates (Area A/B/C in EzMate 401, Area A/B/C/D/E in
EzMate 601).
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453 EnabletheTipsin worktable

Please refer to Section 4.5.1 to Enable the tips in the worktabl e.

4.6 Report

The Report Menu allows usersto review a protocol report and log records.

Fite Edit Protocol Labware i“ﬁeport_i System  Help
|

B Protocol
Log

This option allows users to review a summary of the protocol parameters and
reactions configuration.

® Log

® Protocol

This option alows users to review actions that have occurred during system
operation.

4.6.1 Protocol Report

Click the Protocol option under Report Menu. The opened “Protocol Report”
contains the run set up with the following information on:

»  The protocol name, description and saving location.
»  Automated pipetting module (APM) information

»  All commands settings including Source, Destination, Pipetting Volume,
Pipetting Speed, Mixing etc.

»  Tipinformation including brand, type, capacity volume and the amount
required during the run.

» Labware configuration, brand, location and the amount of reagent required
during the run.

The current time and date.

Software version

26



4 Software

Protocol Report

Mame: Arise

Description: Actin

Mermo: Housekeeping gene
AP Define: 1 Channel 50 pl
File Mame: C:A\Test_1.aps

#1 LT Source(2) Destination(2) Volume(pl) Options
R2(R2-7) B(H-1) 251 Aspiration: Under Liquid Level
R1(R1-4) B(E-12) Aspiration Speed: 1
Digpense Speed: 1
Mz Mo
Tip Change Befare Each Aspiration
#2 MDSource(1) Destination(3) Volume(pl) Options
R2(R2-7) A(O-3) 2l Aspiration: Under Liguid Level
ArH-10) Aspiration Speed: 1
A(0-23) Dispense Speed: 1
Mz Mo
Tip Change Before Each Aspiration
Reverse 2yl
Tip Usage
Name Description Capacity Volume Usage

EzTip 50pl Mon-filtered
Area A: Roche 384 047729749001
Well# Description

A0 ul wifo filter, Mon-Sterile

E0pl 3

Capacity Volume Required Volume Add Volume

0-3 LightCycler® 430 Multiwell Plates 35 20pl
H-10 LightCycler® 480 Multiwell Plates 38 20p1
023 LightCycler® 430 Multiwell Plates 35 20pl

Area B: ABI 96 N8010560

pl 2l
pl 2ul
pl 2l

Well#  Description Capacity Volume Required Volume Add Volume

H-1 Sample 1 200p! pl 25

E-12 MicroAmp® Optical 98-VWell Reactio 200! pl 25pl

Area R1

Well# MName Description Capacity Volume Required Volume Add Volume

R1-4 Eppendorf 0030 1 Safe-Lock Tube 1.5 ml

Area R2
Well# Name Description

18001 250l

pl

Capacity Volume Required Volume Add Volume

R2-7 Malgene 2006-90 Buffer

4.6.2 LogReport

FO00p1 EEN

pl

The log report records every step of arun. Users can tick off “Log” on the System
Menu (System/Software/Log). A log will be automatically generated when every
protocol is started. Please note that the log will be automaticaly saved in the
EzMate file (C:\Document\EzM ate).

To review the log report, proceed as follows.

»  Open the protocol for the corresponding log that you want to review.

»  Click the Log option of Report Menu to display the log record.
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Fie
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ect alog that you want to review.

Log Report

Time Action

?
?
?
?
?
?
?
?
?
*
?
?

it

Chtest_1.aps

APR 1C 50 pl
2011408/26 10:50:54
10:50:54 APS Initial
10:51:10 Drop tip
10:51:20 Pick tip

10:51:23 Move to R2-7 of R2 area
10:51:26 LT Aspirate Yolume: 25p!
10:51:29 Move to H-1 of B area
10:81:32 LT Dispense Yolume: 25y

10:51:37 Drop tip
10:51:42 Pick tip
10:51:45 Move to R1

-4 of R1 area

10:51:48 LT Aspirate Volume: 25p!
10:51:51 Move to E-12 of B area
10:51:54 LT Dispense “olume: 25

10:52:00 Drop tip
10:52:00 Out of Tip !

10:62:06 APS Continue

10:52:11 Pick tip
10:62:14 Move to R2

-7 of R2 area

10:52:16 MD Aspirate Wolume: 2pl x 3 Reverse: 2.0yl
10:62:19 Move to O-3 of & area

10:52:20 MD Dispen

se Wolurne: 2pl

10:562:21 Move to H-10 of A area

10:52:22 WD Dispen

se Wolurne: 2pl

10:52:24 Move to 0-23 of A area

10:62:26 MWD Dispen
10:52:26 Protocol fin

se Wolurme: 2pl
ish drop tip

10:52:40 Total running time:00:02:32

201108/26 10:52:40
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4.7 System

This section describes the EzStarter software system set up. There are seven
sub-categories. Buzzer, COM, APS Connection, Robot Test, Account, Software and
Service Mode in the System menu. Service Mode is only for administrator purpose.

File Edit Protocol Labware Report | Systern | Help

s . . B iiazes
i "
H1 B AFS Connechion
Fobot Test ¥
; Accoure
Software k
Sanace Mada k
4.7.1 Buzzer

When you select the Buzzer, APS will sound under the following situation:
1. Run the protocol and pause the APS.
2. Run the protocol and open the safety door.
3. Run the protocol and when there are not enough tips.
4.APM Time Out (Connection time out error, please see Troubleshooting code

2001).
Systern | Help
Buzzer
COM 3
4.7.2 COM

COM isthe communication port.

| ysimm | Help

Beiizes
COoind ol Wl ALTO
APS Conpectian Commiunication Test

® Auto
When the computer is connected with APS through the USB, the computer will
auto search a COM port to connect with APS and records the COM port in the
computer.
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® Communication Test
This function is to test the communication between APS and computer. You
can key in a number in Run Times and click Run to start the Communication
Test. The Result will display OK upon completion. If communication fails,
“APS NOT AVAILABLE” message will be displayed (please see
Troubleshooting).

Carmmuncaion Tex G ECuvmoﬁu Tes | .
i Error KOM) R

R Tuws o} B P Tores

St Tewa 3 B S Tive

SHE bicia .o PS5 NOT AVAILABLE!

4.7.3 APS Connection

You can use this function to check the APS connection. In the “Apply APS
connection?” window, click and the APS connection will display “Done” or
an “APSNOT AVAILABLE” will be displayed (please see Troubleshooting).

B e = “Error KOGH) e |

Ji Aoply APS cormection] Dz '0 APS NOT AVAILABLE!

. - GE T
{ QK Cancel oK :

474 Robot Test

Users can use Robot Test to confirm the basic APS function. There are 3 items:
Axes Test, Self Run Test and Leakage Test in the Robot Test.

Systam | Help
| Bugar
Ok [
APS Conrmitinn B

Pl Tiastt ] I
Account Sl Aun Test

Enlhame Laskege Test

Service ook b
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® AxesTest
Thisisto check the precision of APM X, Y and Z axes. When you choose Axes
Test and key in a number in Run Times by clicking , the APM will run X,
Y and Z axes. The computer will verify if the steps are correct or not. The
Result will either display PASSED or FAILED (If failed, please contact your
agency).
Axes Test e

Seart Time

Res.n

| Ren

® Saf Run Test
Y ou can do an APM self run test before you run the protocol.  In the Self Run
Test, you can key in a number in Run Times then click . The APM will run
the adapter calibration point of six areas. After Self Run Test, the Result will
either display PASSED or FAILED (If failed, please contact your agency).

Codf B Tast “

P Cyoies |
San Tine Y;MIZ L 1

Rasdt

Rue

# | eakage Test
Users can use this method to do atip leakage test.

Leakage test step:
> First click on [Tip Selection and |Plate Selection to choose labwares, and then
put tip rack and 96-well plate on the D and B areas, respectively.
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Leakage Test f)

Tip Selacsion l Backmanr A2 1578 50 ul wic fier, Non-Starile

Eeter Eadenceiion J AR KED0560 Microdre™ Optcal 55-sli Rascion Plate

Stert Time 425/20\2 30752 Fh

Sakect Tip & Flate St Than Prees Run Butlen

Run

» For the 96-well plate, users will need to load enough water with dye (ex.
Bromophenol blue or Orange G) into H-1 (1 channel) 1 well or A-1 to H-1
(8 channel) 8 wells for the leakage test.

I Clhannel APM 8 Chanpel APM

Lenkaae Test Pasition Top Position Lealinge Test Piation 1op Pinitan

-----------
aanFannnnnnn
...........

------------

ABBRRERARARS ABABRARBARRAAN

> Click sequentially to finish the leakage test.

1. Click = APM will proceed to D area.

2. Click [Next = APM will fit the tip.

3. Click [Nex{ = APM will proceed to B area.

4.Click = APM aspirates 80% volume of liquid (ex. 50ul APM aspirates
40ul liquid, 200ul APM aspirates 160ul liquid), and then
draw aline on the tip with the top of liquid.

5. Click = Leakage Test window will lock the[Next button for 1 minute,
and after 1 minute if the liquid level descends less than
0.5cm of the total liquid level, then the leakage test has
passed. If the liquid level descends more than 0.5cm of the
total liquid level, then the leakage test has failed. (If failed,
please contact your agency).

6. Click = APM dispenses liquid.

7. Click = APM dropsthe tip.
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8. You can click to proceed with the leakage test again or click “Close
button (X)” to finish the test.

Note:
Click and “Close button (X)” to leave the Leakage Test window at
any time.

4.7/5 Account

Only administrators can modify the account. Under Account Administration,
administrators can either add or delete accounts. Administrators can add a new
account by typing in the account name and the information on the last row that has
a “«” symbol. Administrators can delete an account and the information by first
selecting the account and pressing the “Del” button on the keyboard. If the
Administrator changes and forgets its password, please contact the Authorized
Distributor for help. The Administrator can add a new account, only when the
End-user group is selected in the Function block.

g Bocwund &b rivab oe E_
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476 Software

There are seven items. Hint, Recently File Open, Finish Aphorism, Log, Labware
Grid Lines, Command Auto Check and Database in the Software menu. These
functions are described bel ow.

-

| Software k | Hint

Service Mode r Recently File Open

Finish Apheorism

Log

Labware Grid Lines
Command Auto Check
Database
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® Hint
When users select the labware, and move the cursor to this labware, the labware
information will be displayed.

Eppendorf 0030 120,086 150001 ]
# Recently File Open

When users open the EzStarter software, it will aso open the file that was used
last time.

® Finish Aphorism
When the protocol is finished, the Run Information message will show and an
ending tune will sound.

Start Tirme 340:24 P02
Finizh Time: 3:41:00 PM
Elapsed Time 000135

oK

® Log
EzStarter software will record every step of arun. Please see 4.6.2 Log Report.

® |abwareGrid Lines
It will add grids on the labwaresat A, B, C and D aress.

A:ABI 95 N8010560 A:ABI1 96 Ne010560

S6HNHHA66666 SNONHHMHOS
o s B 9 e B f B B Grid Lines 6666606606666
S6HH66666666 SN0 6606666
OONNHA6666 —> 6N HAGHMH66
o s B 9 B 6 B B B B B 6 S06M0MMHMS
OONNHH6666606 60000600666
1 s B 9 B9 6 B B B B B 6 SN60EMHMHMS
SN HA66666 SN
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® | abwarelIndicator
This function will add labels around your selected labwares.

A:ABI 96 NB010560 ARBISENEDIOSED
Y YY YLl LLY N YL Y Y IY YT LYY
XYY Y YL LLY T Y YLl LY
Y Y LI LYY Y) Labels T Y YL YLY)
PPOOPPOOENOOS |, -GN
XYY Y YL LLY T Y YL LY
XYY Y YL LLY Y LI LY
XYY Y YL LLY Y Y I LY
XYY Y YL LLY Y Y YL Y)

® Command Auto Check
When users set a new protocol and add a new command, without selecting the
source or destination, the software will remind users to select them.

ANy I ETTENT IR AT | i
Miscage (== N Mg =5
o Nowell 15 selectad 0 No sounce well is selected lo No desbnation ael & seected
(' g Ll ' -Cm(d ] GK | | Leacd [ ak i Cancel
# Database

This function is to export and import labware raw data to other computers.
The Update and Restore functions are for importing data. Update will add new
labware raw data to EzStarter, and Restore is to replace with new labware raw
data.

R
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4.7.7 Maintenance Aphorism

APS and APM have maintenance time.

||_.l‘ Flardbamance Aghanem E
Flame SPS Wairtermnce Aphonsm bder Werang 1K Hoars
Fama LW Mamiesngncs Aphonam bGer Visdong [LEE LI Times=s
[¥] Aphosym: g

EzMate 401/601 help information is available in the Help Menu.

481 How Dol

The operation manual will guide usersin using EzMate 401/601.

4.8.2 About

Displays information about the EzMate 401/601 Software, APS and APM.
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5. Work Tab Overview

e - <=
- . s
»
&) €7 Joe S @
i Bl

The Worktable (section 1) is displayed on the top left section of the main window.
Labwares can be defined on the worktable via the mouse.

The Protocol List (section 2) is displayed on the bottom left section of the main window.
It shows all commands and the parameters for each command.

The Pre-Run and Run section (section 3) is displayed on the bottom right section of the
main window. Y ou can pre-run or run your protocol.

The Properties section (section 4) is displayed on the top right section of the main
window, and contains general information on the system.

5.11consintheWork Tab for EzM ate 401/601

Toolbar

The Toolbar alows easy access to and exposes some of the main functions in the
software. These are described here.

O om e | b + X
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Icon Description Function
New Protocol | To create anew protocol file.
Open Protocol | Allows you to select and open an existing protocol file
i | SaveProtocol | To savethe current running protocol asa*.aps protocol file.
oy Saveto New Save as the current running protocol to anew protocol file.
' Protocol
- | Print To print a protocol file..
w | Preview To preview the printing.
. Run To run aprotocol file.
y | Pause During a run, click on this icon to pause the run. Click on the
icon ¥ to resume the run.
s | Stop All During arun, click on thisicon to abort the run
Add Add anew command in the protocol
Delete Delete acommand in the protocol

5.2 Worktable

Worktable is designed for labware settings.

» EzMate 401/601 has six/eight areas A, B, C, D (plus E, F for 601), R1 and
R2in worktable.

Area Adapter Labware
® 8-tubes PCR strip
® 96-well adapter ® 96-well PCR plate
® 384-well adapter ® 3384-well PCR plate
® 20-well adapter ® 1.5ml tube
A,B,C ® Deep well adapter ® 2ml tube
(A,B,C,D,Efor | ® Terasaki tray adapter ® Deep wdl plate
601) ® 96-well conical adapter | ® Terasaki tray
® ELISA/Cdl culture ® 6~384-well ELISA/Cdl
adapter culture plate
® |llumina adapter ® |llumina48-well PCR
plate
C,D
(C,D, E, Ffor ® Tiprack adapter ® 50ul and 200ul tip racks
601)
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5 Work Tab Overview

Area Adapter Labware
® 15ml, 2ml tube
® RI1 adapter
® 5ml bottle
® R2 adapter .
R1 . ® 80ml reservoir
® Reservoir adapter )
. ® 15ml reservoir
®  3x 8-strips adapter )
® 38-tubes PCR strip
® 1.5ml, 2ml tube
® RI1 adapter
® 5ml bottle
® R2 adapter .
R2 _ ® 80ml reservoir
® Reservoir adapter .
®  3x 8-<trins adapter ® 15ml reservoir
X 8-stri _
PS adap ® 8-tubes PCR strip

1. A, B,C(A, B, C,D andE for 601) areas are for SBS format microplate, 20-well,
deep well plate, Terasaki tray, ELISA/Cell culter plate and Iliminar plate
adapters.

2.C,D (C, D, Eand Ffor 601) areas are for tip rack adapters.

3. R1 and R2 areas are for 1.5ml/2ml tube adapter, 2ml tube/Sml bottle adapter,
80ml reservoir adapter, 3 x 15ml reservoir adapter and 3 x 8-strip adapter.

5.3 Protocol List

The protocol list shows all commands on the worktable. There are six commands;
Liquid Transfer, Multiple Dispenses, Seria Dilution, Hold, Mixing and Loop.

5.4 Pre-Run and Run

When you set up a new protocol or open a protocol file. You can click PRERUN to
check if the protocol is correct or not, then click RUN to test.

5.5 Properties

Properties section shows Worktable and Protocol information.

Properties

Protocal W
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Worktable

Displays Worktable information, such as labware vendor and model. Users can
activate 20-well adapters and reservoir adapters in the Properties/Worktable before
select any labwares in the Stepl Worktable. To activate reservoir adapters and
20-well adapters, please see section 6.2.1 Reagent Area (R1 and R2) and section
6.2.2 Worktable Area (A/B/C for EzMate 401, A/B/C/D/E for EzMate 601).

Frofetes

Protocol
Displays Protocol information. Users can key in Description and Memo information
in the Profile. Thisinformation will be saved inside the protocol file.

Propertias
Frotocol -

B

H Profl=
AP Cherne] 1
AsprabegThapersing Sequences  [Manaal
Cmpecity Woluma LT |
Dieseripdion PO st
Meamg GAFDH lest

H S MERTEENp
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6 Operation

6. Operation

Operating the EzStarter is as easy as 1-2-3. Users only need to follow Step 1-2-3 shown
on the screen to create, pre-run and run a new or existing protocol file. To prepare your
protocol file, first select the labwares for the Areas (RL/R2/A/B/C/D for EzMate 401,
R1/R2/A/B/C/D/E/F for EzMate 601) in the “Step 1 Worktable” section (Section 1). Then
prepare your commands in the “Step 2 Protocol” section (Section 2). Lastly, pre-run or
run the protocol in the “Step 3 Run” section.

6.1 Create A New Protocol

Double-click the Arise EzStarter icon on the desktop. Once EzStarter boots, the
login screen will appear. Enter the account name and password, and click Login.
EzStarter will start anew protocol file screen such asthis:

D T EEEEEE——————. .

Treew
B L -
i ™ 4
- - 4 ]l
. 2~ Tl
R s i
iremgle ey e E—
e . 1/
—
=]
- -
* -
ETHT
[[PT TESey S

€ 2 m J’B (=

fpira Bl

Note:
A new protocol file (Format: *.gps) should include the labware information, a
protocol (aseries of commands) and the properties information.
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6.2 Selecting the Labwares

Select the labwares after starting a new protocol file. Please follow the section below
to select the labwares for different areas on the worktable. Once the labwares are

selected, the selected labwares and its positions will apply to al commands.

6.2.1 Reagent Area(R1and R2)
1. Users can left-click "= icon on Worktable to choose proper Adapter in the

Stepl Worktable.

El

Lt
= R1 Adapter
\: R2 Adapter
Reservoir Adapter
15ml = 3 Reservoir Adapter

3 Strip Adapter

2. Left-click on the Reagent Area R1 location. The available tube/reservoir list

will be displayed.

3. Select the tube/reservoir you want to position on the Reagent Area R1. The
selected position will be highlighted in gray.

S L3t che oo
. -
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6 Operation

4. Repeat steps 1 and 2 to select the Labwares for the other positions on the
Reagent Area R2.

|
|. i S I
By ST B

6.2.2 Worktable Area (A/B/C for EzMate 401,
A/B/C/D/E for EzMate 601)

1. If users want to use 96 well or 384 well microplate, left-click on the I® icon at
the upper right hand corner of the Area A and B without choosing = icon.
The available microplate list is displayed.

2. Select the microplate (96 well or 384 well) you want to position on the Area A
and B. The selected location is highlighted in gray and the name of the
selected item is shown on the upper left-hand side of Area A and B.

o

T i i T
T T I T T TN NN
. R e ]
e T o
s s ETR e o D
e T T I T I T LY
i T T T I T T L L.

_T IR sIEEEE RN

! T Ll L LT
oia b BT SRE L L L E L B N B _N_H O d_J |
L LI I N T

Thename of Labwareis

"
R RIE

shown.
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3. If users want to use labwares with special adapter, they need to click Special
Adapter icon (2 ) on Area A and B to choose one of the special adapter
before selecting any labwares.

*
+ = | Oriunis
Ebwostad Lirs- 5] Veth
Ebsvarad 20 Wl
larmsa b el
Termsia T Weln
] Tewacid o0 Wels
e

4. Left-click on the worktable area, and the available vessal list will be displayed.
5. Select the vessel you want to position on the area. The selected position will be
highlighted in gray.

202D
2292)
22222

B pndoc (00 170088 1508y
Sarvimat 7200 005 R1 100y |

- 29022

% £
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6 Operation

6. Area C (EzMate 401) or Area C/D/E (EzMate 601) are designed for both
vessels and tips. Its labware list includes available microplates, tubes and tips.
Repeat steps 1 ~ 5 to assign vessels to these areas. Refer to following Section
6.2.3 if you want to use tips on these areas.

Protoacd
AE( B5 HEAOL0SED
AE] 239 AF0GE4D D

Sarteck 96 Deep-WWell 82,157,002

34|

&

EXTig 30ui1 Mon-Tic e e w

o~ Tip list: 50 ul tip, 200 ul tip

c 'ﬁ-’l Pedncol

— =] &
| =] £
Dafaiilt
Eberwartid Ure-20 Wsllc
Elrwerted X) Wiells Elevated 20-well adapters,
Terpzak &) Walk
Terpzak 72 Welk

i} Tersrak 36 Welk
- S

Terasaki tray adapters

6.2.3 Worktable Area (D for EzMate 401, F for
EzMate 601)

1. Left-click the icon on the upper right-hand corner of Area D (EzMate 401) or
AreaF (EzMate 601). The available Tip list is displayed.

2. Select the tip you want to position on Area D (EzMate 401) or Area F (EzMate
601). The selected location is highlighted in gray and the name of selected
item is shown on the upper left-hand corner of Area D (EzMate 401) or Area
F (EzMate 601).

{

o (] Wl Tt Irmsd [D:Becknmn 5000 Non-filtered |

.fﬁ' - S 6H 666666

Beckman S0yl Non-fkered Y Y YT YT

EzTe S0yl Mor-fikered AHOHOHHO6H6H

; 66666666666

GEHHGH6H6666666

6666666666

AFH Clianse] OHHHH6666666

Tha APHL Chazral Horabar 6666666666
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6.2.4 Removinglabwaresfrom Area

1. Right-click on the labware you want to delete.
2. Select Remove from the context menu.
3. The gray labware icon is removed from t.

The labwareisremoved

...

from Reagent Area R2.

Note:

The labware selection can be removed only when all the selected wells of all
commands are removed.

6.3 Editing the Protocol

After selecting the labwares, users can set up a sequence of commands as the
protocol in “Step 2 Protocol” section (Section 2). Each command includes a
command tab which includes the command number (#) and command function, a
Source button to select the source wells of reagent/sample, a Destination button to

select the destination wells of reagent/sample and an Option button to select the
parameters of function.

6.3.1 Adding a command

Follow these steps to add a command to the procedure.
1. Left-click on any command Tab of the protocol.
2. Right-click on the command Tab and select Add from the context menu or

select Add from the Edit Menu.
/Right-click on the command Tab and the context menu is shown.
B R = !
| € e [ B €
Swewr L Speinfo,. CTRL ST | b | s pir b 1%



6 Operation

3. The new command # L T]is added next to the original command. From the
drop-down menu users can change the function of the new command
into any other function. The new function is added into the protocol.

g , New command

/ -
_“:.“::m. O =0—

w—Emn 1 Froiood

/ To edit the new command from menu.

i

f%%r—w; ] - [

il

-md

=]
The new command isadded.
~Eha 3 Prodeeal /
e,
H.l-[h-'-

H‘l’#‘:-w; F} BoaicE .¥;__:ﬁ”-.:.

4. Complete the protocol by adding other commands in the same way.

6.3.2 Removing commands from the procedure

To remove one or severa commands from a protocol, please follow these steps..
1. Left-click on any command Tab that needs to be removed.

2. Right-click on the command Tab and select Delete from the context menu or
select Delete from the Edit Menu.

right-click on the command Tab

and-theeontext menu is shown.

Diwbety
~—Ling I Profzcd Duglcain CTAL =D b—— S iFI —_—_—_—— Tuglicate CTAL+ 0 I
Eccharge ETAL+ E Exchungs LT« E
no LA T 2
bl Lippars - L o ! Wit Derparmm it
' 52 G st CTRL =1 ' E; iy et
3 3 { ) . H =
§ e i =] 5 Rt b aEERE Sadng !
L4 Syuiem Offtin, Samglednfo.  [TAL+E < Syt (Hfline Sarmgielnfa, CTAL=+5

3. A warning message will appear. To delete this command, click “Yes”. The
command will then be removed from the protocol.
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. Thecommand#2 is deleted.
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6.3.3 Duplicating a command

To duplicate acommand, including its parameters and options, please follow these

steps.

1. Left-click on the command Tab that needs to be duplicated.

2. Right-click on the command Tab and select Duplicate + D) from the
context menu or select Duplicate from the Edit Menu.

right-click on the command Tab

and the context menu is shown.

—Eip d Fioesed CTRL + O D'!!tlll CTRL+D
— Tl = E Exchangs B LE
T . . " | Dt |
[ Avmmst 5] [reten THE 4 | frmd i J i -
S A
BY Syctewm M o, cTRL- S Samglebrly, CTRE +5
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3. The command is duplicated and the duplicate is next to the original

command. Users can edit the parameters of the original command and the

duplicate independently.
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Thecommand#1 is
L o duphcated to command#2.
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6.3.4 Insertingacommand

To insert acommand into the procedure at any position, please follow these steps.

1. Left-click on the command Tab to insert anew command before it.

2. Right-click on the command Tab and select Insert (Ctrl + 1) from the context
menu or select I nsert from the Edit Menu.

To insert a new command

/ before command#2 M D.

/

—meg 2 Protood

- e;

Dot |

©)

Right-click on the command Tab

and the context menu is shown.
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3. A new command is inserted before the original command. Users can
change the command to other command functions from the drop-down
menu.

/ A new command isinserted before the M D command.

nir
|.!C|A.|lC| Tl'H\'I'H F} ml& Q; lrlllrlm |
Al'\:lr\-:n _'\I].l" 1 l] A "

~biwp 2 Projzcod

, Edit the new command#2 to other application that you wish.
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6.3.5 Exchanging a command

To exchange a command, please follow these steps.
1. Left-click on one of the command Tab to exchange.

Select the command that you want to move down.
200 & Pl

N

Al CT alit

f_'.%.imﬂmm?:E;: Fustion E"ﬂ'mﬂ“ @};“ﬂm

2. Right-click the command Tab and select Exchange (Ctrl| + E) from the context
menu or select Exchange from the Edit Menu.

Delete
~aiep I Profed —————————— Duglicute CTAL+ 0
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3. The command will move one command behind.

The M1 X command move from #2 to #3.

pd
7
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6 Operation

6.3.6 Resetting source and destination of a command

To clear the source and destination setting of a command, please follow these
steps.
1. Left-click the command Tab to remove the source and destination setting.
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Select the command that you wish to reset the setting.

2. Left-click the command Tab and Select Reset from the context menu or salect
Reset from the Edit Menu.
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3. A warning message appears. To reset, click “Yes”. The command will be reset.
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6 Operation

6.4 Command Overview

All available command functions are displayed in the drop-down menu in Step 2.
Protocol section. There are six command fucntions, including Liquid Transfer (LT),
Multi-Dispense (MD), Seria Dilution (SD), Mix, and Hold and Loop. Each
command includes its individual settings, such as command function, source and
destination positions, volumes and option, and so on. All commands are numbered in
command tab, according to their processing order. The command tab also includes
the abbreviation of command function. The default setting for a newly added
command is Liquid Transfer (LT). The user can change the default command
function from the drop-down menu.

Loy ... Click the drop-down menu, there are 6 commands.
Py — :

6.4.1 Liquid Transfer (LT)

Use Liquid Transfer (LT) command to transfer liquids (Reagents and Samples)
from several source positions to several destination positions (One to One),
please follow these steps.

1. Select Liquid Transfer command from the drop-down menu.

Select Liquid Transfer from drop-down menu.

e
. "4 - LTI
=i 1
Actomroad Satiing ; ? ?) 1.0 v

2. Selecting Source and Destination Positions.
The user must select the source and destination positions on the labwares for each
command. The labwar e must be placed on the wor ktable befor e operation.

# |mmediately upon adding a new command, users can select the source and
destination positions by right-clicking the positions or framing an area.

®Press the %4 putton, then click on/frame in one or several positions
where the liquid will be extracted from the Worktable. The selected positions
are highlighted in blue.
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~Elmp & Profoocl
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\ Press “Source” button to set source.

® Press the [ ®#%5 " putton, then click on/frame in one or several positions
where the liquid will be dispensed on the Worktable. The selected positions are
highlighted in red.

S0 2 Frosmod
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Press “Destination” button to set destination positions.
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® EzStarter will record the selected pattern sequence and the EzMate 401/601
will transfer liquid from one source position to another destination position as
the sequence defined by users.

3. Setting Dispense Volume
Key-in or press up and down key to set the volume to be dispensed. The volume
setting ranges of different APM models are shown below.
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APM 50 pl Model | APM 200 pl M odel

Volume Range 1~50ul 10~ 200 pl
Volume Increment 0.5ul 1l
Fiogsnes
Progaaad -
e B
[ @ ProWe
L] Trarmimr - : S Ceisdaeod L TLI-.-II.-W- e |
e~ \ 7 crr— S Max, setting volume of APM

T

[ Serrramy

Set Working Volume

4. To specify further Advanced setting for the command, click on the | sssssas
button to edit the location of Aspiration and Dispense, speed of Aspiration and
Dispense, Mixing, Tips Change, Extra Aspiration (Reverse) and Blow-out.

6.4.2 Multi-Dispense (MD)

Use Multi-Dispense (M D) command to transfer liquids (Reagents and Samples)
from one or several source positions to another destination positions (One to
Multiple or Multipleto Multiple).

After the settings are completed, the sum of the dispensing aiquots is aspirated
into the tip. The APM aspirates from the first source position and dispense the
setting volume to several destination positions sequentially. Next, the APM
continues to aspirate from the second source position and dispense the setting
volume to severa destination positions sequentially. EzMate 401/601 will
continuously operate in the same way to compl ete the command.

Note:
To increase the MD accuracy, MD default setting is designed to aspirate extra
liquid volume (Reverse pipetting).
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Multi-Dispense Default APM 50 pl Model APM 200 pl Model
Setting

Rever se pipetting 1ul 10 ul

Tip Change Before Each Aspiration | Before Each Aspiration

1. Select M ulti-Dispense command function from the drop-down menu.

2. Select the Source and Destination Positions

The user has to select the source and destination positions on the labwares for
each command. The labware must be placed on the worktable before

operation.

® Immediately after a command has been added to the procedure, select the
source and destination positions by right-clicking the positions or framing an
area.
® One Source position to multi Destination positions
» Pressthe == button, then click on/frame in one position where
the liquid will be taken from the Worktable. The selected position is
highlighted in blue.

> Press the [ === | putton, then click on/frame in multi positions
where the liquid will be dispensed on the Worktable. The selected
positions are highlighted in red.

Destination x 6 wells
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» EzStarter will record the selected pattern sequence and the EzMate 401/601
will transfer the liquid from one source position to multi destination
positions as the sequence you defined.
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»  For example:
APM takes 7 pl liquid from 5 ml tube at R2 Area - Dispense 1pl to AreaB,
Al well > Dispense 1ul to Area B, A2 well - Dispense 1pl to Area B, A3
well = Dispense 1pl to Area B, C1 well - Dispense 1pl to Area B, C2
well = Dispense 1pl to Area B, C3 well

® Multi Source positionsto multi Destination positions

> Pressthe == putton, then click on/frame in multi positions where
the liquid will be taken from the Worktable. The selected positions are
highlighted in blue.
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>  Pressthe [ B button, then click on/frame in multi positions where
liquid will be on the Worktable. The selected positions are highlighted in

red.
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» EzStarter will record the selected pattern sequence and the EzMate
401/601 will transfer the liquid from multi source positions to multi
destination positions as the sequence defined by users.

» For example:

APM takes 17 pl liquid from 2 ml tube at R2 Area - Dispense 1l to
Area A, A1 well & 1pul to B1 well-> 1ul to C1 - 1ul to D1 - 1pl to E1
- 1yl to F1 > 1pl to G1 - 1pl to H1 - 1pl to A2 - 1ul to B2 - 1pl to
C2 - 1ul to D2 - 1pl to E2 - 1l to F2 - 1pl to G2 - 1ul to H2 >
Change Tip = APM takes 17 pl liquid from 5 ml tube a R2 Area -
Dispense 1ul to Area A, A1l well - 1ul toB1-> 1ul toC1 - 1yl toD1 -
1ul to E1 = 1l to F1 - 1pl to G1 - 1pl to H1 - 1pl to A2 - 1ul to
B2 2> 1pl to C2 - 1ul to D2 - 1pl to E2 & 1l to F2 & 1l to G2 >
1l to H2

3. Set the dispense volume

Key-in or press the up and down key to set the volume to be dispensed. The
volume setting range is based on the APM model. | f the dispense volume of each
well x number of Destination Wells is greater than the maximum_ APM
volume, then the APM will perform additional pipetting cycle.

For example:

APM Model: 50 pl

Dispense volume/each well: 20 pl
No. of Destination Wells: 3

The APM aspirates 40 pl (20 pl x 2 wells = 40 pl < the APM Max. volume: 50 pl)
from the source position and dispenses the setting volume to the first two
destination positions sequentially. Next, the APM continues to aspirate 20 pl from
the source position and dispense to the third destination position.

» For example:
APM takes 41 pl liquid from 2 ml tube at R2 Area - Dispense 20 pl to
Area A, A1l well - Dispense 20 pl to B1 well = Change Tip > APM
takes 21 pl liquid from 2 ml tube at R2 Area - Dispense 20 ul to C1 well
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4. To specify further Advanced Setting for the command, click on the | sssssas
button to edit the location of Aspiration and Dispense, speed of Aspiration and
Dispense, Mixing, Tips Change, Extra Aspiration (Reverse), Blow-out and
Conditioning Volume.

6.4.3 Serial Dilution (SD)

The Serial Dilution (SD) command is a modified Liquid Transfer command to
facilitate the performance of the dilution series. A defined volume s transferred
from one well to the next several times.

1. Select Serial Dilution command from the drop-down menu.

2. Select Diluent, Sample and Reaction Positions

Users will need to select the diluent, sample and reaction positions on the
labwares for each command._The labware will need to be placed on_the
wor ktable befor e operation.

#® Immediately after acommand has been added to the protocol, select the diluent,
source and reaction positions freely by right-clicking on the positions or
framing an area.

®Press the [ 8% putton, then click on/frame in one or multi positions
where the liquid will be taken from the Worktable. The selected positions are
highlighted in blue.
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®Press the [ %% button, then click on/frame in one or multi positions
where the liquid will be taken on the Worktable. The selected positions are

highlighted in red.

Sample x 8 wells
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®Press the |« putton, then click on/frame in one or multi positions
where the liquid will be dispensed on the Worktable. The selected positions are
highlighted in Orange and Y ellow.

Sample x 8 wells
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® EzStarter will record the selected pattern sequence and the EzMate 401/601
will transfer the liquid from one source position to one destination position as
the sequence defined.

3. Set the volume

Key-in or press the up and down key to set the Diluent volume to be taken and the

Sample volume to be taken. The volume setting range depends on the APM

model.

‘ mmr\r E;h Od : & Gls:uiﬁﬂ; $ ?_}..El-:t?“m 1:-—.:.”“

Set working volume

4. Set Reaction Cycles

The default Reaction Cycle is 2 times. Users can key-in or press the up and down
key to set the cycle times. After you set the cycle times, press the [ Ssds
button again or click on any buttons/dialogue boxes, the final reaction wells will
be displayed.

Press “Reaction” button
~bimp 2 Profoood

nir w3E
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Set Working Cycles
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Note:
Advanced Setting- Dilution Direction: sets the direction of reaction positions

»  Select “ Horizontal (Default)”
- The default dilution direction is Horizontal. If Horizontal is
selected, the reaction wells will shift from left to right —.

For 96 well plate, the reaction cycle rangeisfrom 2 to 12 times.
For 384 well plate, the reaction cycle range isfrom 2 to 12 times.

»  Select “ Vertical ”
Users can change the dilution direction to Vertical. If Vertica is
selected, the reaction wells will shift from top to down|.

For 96 well plate, the reaction cycle rangeisfrom 2 to 8 times.
For 384 well plate, the reaction cycle range isfrom 2 to 12 times.

5. Set the Mix Cycles
The default of Mix is 10 times. Users can key-in or press the up and down key to
set the cycle times, which ranges from 1 to 100 times.
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Set Mixing Cycles
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6. To specify further Advanced setting for the command, click on the | s
button to edit the Mixing speed, Mixing Volume, Tips Change and Dilution

Direction.

6.44 Mix

Use Mix command to mix liquids within a position. While the liquid is being
mixed, it will aspirate into tip and dispense back into the same well.

1. Select the Mix command from the drop-down menu.

2. Select the Positions

Users have to select the mixing positions on the labwares for each command. The

labwar e must be placed on the worktable before operation.

#® Immediately after acommand has been added to the procedure, users can define
the mixing position freely by clicking on the mouse.

®Press the %= putton, then click on/frame in one or multi positions
where the liquid will be mixed on the Worktable. The selected positions are
highlighted in blue.
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® EzStarter will record the select pattern sequence and the EzMate 401/601 will
mix liquid as the sequence is defined.

3. Set the Mix Cycles
The default of Mix is 10 times. User can key-in or press the up and down key to
set the cycle times, whose range varies from 1 to 100 times.

4. Set the Mixing Volume

Use the drop-down menu to select the Volume % or Fixed Volume for the
mixing volume. Users can key-in or press the up and down key to set the Mixing
Volume that is to be aspirated and dispensed during the mixing process. The
default of mixing volume is 50% for Volume % mode and 1.0 pl for Fixed
Volume mode. Users can set the range from 40 to 70% or volume up to the
capacity of the tip used.

® Upon setting the Mixing Volume (%), EzStarter will automatically add the total
dispensed liquid volume of the selected positions. Then, calculate the Mixing
Volume that is to be aspirated and dispensed.
> Total dispensed liquid volume of a position x Mixing Volume (%) =
Mixing Volume

#® The Mixing Volume should be = the APM maximum aspiration volume
(APM50wax 1S 50 pl, APM200 4 is 200 pl). If the Mixing Volume is = the
APM maximum_aspiration_volume, then the APM will aspirate and

dispense the maximum volume.

5. To specify further Advanced setting for the command, click on the | ssss s
button to edit the location of Aspiration and Dispense, Mixing speed, Mixing
Volume and Tips Change.

6.45 Hold

The Hold command specifies a defined pause before the next command. The
APS will continue automatically after the hold time has lapsed or wait users to
press the[Continug button to continue to the next command.

1. Select Hold command from the drop-down menu.

2. Select Time
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Users can key-in or press the up and down key to set Time that is the duration of
pause. The maximum Hold timeis 23 Hours 59 Minutes 59 Seconds.

— S0 2 Prosocil

wus
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?’ 23 Hon + S5 Werates $ 59 Cacorcs z I Thes Lortirum
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#® When the protocol processes the Hold command, the timer will countdown. The

status bar flashes and display the message “ Time Remain in xx:xx:xx ”.
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3. Select Continue or Wait

Immediately after the hold time is set, users can set how to process the next

command. Press on the up and down key to set Continue or Wait.

® Select Continue: the protocol will continue automatically after the hold time has
lapsed.

® Select Wait: wait for the user to press the button to continue to the
next command. The status bar flashes and displays the message “Press
[Continue] Button to continue”.

=

ree A c’,,“, e Svae Te E

Press “CONTINUE”
2 — button to continue

© i

6.46 Loop

Use Loop function to repeat several commands one or several times. Loop
allows users to select a few commands (from the Start Command to the End
Command) and repeat them in selected times.

1. Select the L oop command from drop-down menu.
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2. Select the Start command
Press the up and down key to set the Start Command which is next to the Loop
command.
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® Users must set the End command as the command before the Loop command.
> For example: When the Loop command is in the sixth steps , the
End command must be the fifth steps.

3. Select Repeat Cycles
The default Repeat Cycle is 1 time. Users can key-in or press the up and down key
to set the cycle times, whose range varies from 1 to 11 times.
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4. Submit Setting
® Immediately after the command setting is completed, press on the
button.
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Press “Submit” button
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® Click button and EzStarter will

automatically caculate the

feasibility of the loop. If the all settings are reasonable and feasible, a message

window will show “Submitted”. On the contrast, it will show “Loop
Submission Failure!”.

#® After submitting the Loop setting, the Worktable will display the pattern that
will be assigned to the protocol and the button will switch to
EEESS putton. The columns of Start Command and Repeat Cycles are

locked for change.
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5. Edit or Remove Loop Command

® |f users want to edit or delete the Loop command, press WEEEEESSE pbutton. A
message window “Refuse Will Reset All Loop Submitted” will display.

®|f users click “Yes” to delete the Loop setting, the pattern of Worktable will be
cleaned and the MEEEESSM button will switch to button. The
columns of Start Command and Repeat Cycles are open for input.
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6.5 Commands’ Advanced Settings

The following Advanced Settings are used for advance setting. Users can edit these
parameters according to their requirements. Press the “Advanced Setting” button to
enter the Advanced Setting setup. Press the “OK” button to save the Advanced

Setting, or press the “Cancel” button to close the window without save the Advanced
Setting.

6.5.1 Liquid Transfer’s (LT) Advanced Setting

® Aspiration Location: the location where liquid is to be aspirated.

»  Select “ Under Liquid Level (Default)” or from “ Bottom ™ .

-Under Liquid Level (Default): We have divided the vessel and plate into
several height segments which are used for the virtual liquid level by
calculation. For example: 2.0 ml tube is divided into 20 height segments.
The pipette tip is generally immersed 2 to 3 mm into the liquid level before
aspiration. The pipette tip will move downward gradually, because the
liquid volume will decrease during aspiration.

- Bottom: thetip is positioned approximately 2 mm above the bottom of the
vessel or the plate. The distance from the bottom of the vessel or the plate
depends on the vessel’s or plate’s type. For detailed Labware information
please refer to Appendix B: Recommended Labwares.

-Top: thetip is positioned on the top of the vessel or the plate.
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® Aspiration and Dispense Speed: sets aspiration and dispense speed.
» Fivegspeedsareavailable, from slow to fast. The default speed is slow.
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» APM aspiration and dispense speed table (The aspiration and dispense

speeds are the same.).
APM 50pl (ul/sec) APM 200p] (pl/sec)
Speed 1 (Slow) 24 83
Speed 2 29 103
Speed 3(Middle) 37 133
Speed 4 51 190
Speed 5 (Fast) 83 333

®Mix

» The default setting is “N0”. Select “Yes” if the liquid needs to be mixed.
3 conditions. “After Dispense (Default)”, “Before Aspiration” and
“Both Dispense & Aspiration” can be selected from the drop-down

menu.
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- Set Mix Cycles: from 1 to 100 times. The default is 10 times.
- Set Mixing Volume: from 40 to 70% or up to the capacity of the tip used.

The default is 50%.

- Set Mix Speed: five-speeds from slow to fast. The default speed is slow.
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@ Tip Change: set when to change tip
»  Select “Yes” to specify when the tips are to be changed. 3 conditions:
“Before Each Aspiration (Default)”, “When A Command Finishes” and
“After xx Aspirations” are available.
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Tip hange
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»  Select “N0”: Not to change tips. This option will affect the accuracy of the

pi petting.
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® Method:

» Use the Method drop-down menu to specify the pipetting method. The
default setting is Standard Pipetting. You can select “ Rever se pipetting

“or “ Blow-out .
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>  Reverse pipetting (Extra Aspiration): If the Reversed pipetting function
is selected, you can set how much extraliquid will be aspirated. The default
reverse volume of APM50 Module is 1.0 pl, while APM200 Module is 10

pl.

The maximum reverse volume is 10% of the APM’s maximum aspiration

volume.
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Rever se Pipetting Volume of APM50 is 1.0 to 5.0 ul, while APM 200 is 10 to
20 pl.
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Note:
If the reverse pipetting function is selected, the Tip Change options will
not be available.
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Tip Change options are not available

»  Blow-out (Post-Air): If the blow-out function is selected, users can set
how much air will be blown after each dispense. The default post-air
volume of APM50 Moduleis 1.0 pl, while APM200 Moduleis 10 pl.

The maximum post-air volumeis 10% of the APM maximum aspiration volume.
Post-Air Volume of APM50is1.0to 5.0 ul, while APM 200 is 10 to 20 ul.
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Note:
If the blow-out function is selected, the Mix option will not be available.

6.5.2 Multi-Dispense’s (MD) Advanced Setting

This Multi-Dispense (MD) Option is the same as the Liquid Transfer (LT)
command Option, so please refer to 6.5.1 Liquid Transfer (LT) Option section.

6.5.3 Serial Dilution’s (SD) Advanced Setting

® Dilution Direction: sets the direction of reaction positions.
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»  Select “ Horizontal (Default)”
- The default dilution direction is Horizontal. If Horizontal is selected,
the reaction wells will shift from left to right —.
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For 96 well plate, the reaction cycle rangeisfrom 2 to 12 times.
For 384 well plate, the reaction cyclerangeisfrom 2 to 12 times.

> Select “ Vertical

- Users can change the dilution direction to Vertical. If Vertical is
selected, the reaction wells will shift from top to down]|.
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For 96 well plate, the reaction cycle rangeis from 2 to 8 times.
For 384 well plate, the reaction cycle range isfrom 2 to 12 times.

-

#® Tip Change: sets when to changetip

>

For Buffer/Diluent: select change tip “Before Aspirate Sample (Default)”
or “Each Aspiration ”.
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-The default Tip Changes for Buffer/Diluent is Before Aspirate Sample.
If option is selected, APM will use the same tip to aspirate and dispense
Buffer/Diluent. It can save the usage of tip, but the accuracy may decrease.
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-Users can select Each Aspiration; APM will use new tips before each
aspiration. If the buffer is viscous, we suggest to change the tip before
each aspiration to increase the accuracy and precision.

» For example: select Tip Changes> “Before Next Sample (Default)” or
“Each Dispense”.

-The default tip change for Sample is Before Next Sample. If users select
the option, APM takes sample #1 - dispense sample #1 to reaction well
#1 - Mix - take the diluted sample from reaction well #1 and dispense
to reaction well #2-> Mix - change tip before APM takes sample #2

-If users select “Each Dispense”, APM will use new tip after each
dispense.

#® Mixing Volume (%): Set the Mixing Volume (%) that is to be aspirated and
dispensed during the mixing process.

» The default of Mixing Volume (%) is 50%. Users can set the range from
40 to 70%.
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® Mix Speed

» Five-speeds are available from slow to fast. The default speed is medium.
If the liquid foams up, we suggest set the mixing speed to the slowest.
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6.54 Mix’s Advanced Setting

#® Tip Change: sets when to changetip

» Select “Tip Change” option to specify when the tips are to be changed. 3

conditions: “After Each Mix (Default)”, “When A Command Finishes”
or “Not” are available.
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® Mix Speed
» Five-speedsareavailable from slow to fast. The default speed is medium.
If liquid foams up, we suggest to set the mixing speed to slowest.

6.6 Run and Pre-run

After selecting the labwares and setting the protocol, users can proceed to Step 3.
Run (Section 3). In this section, there are two options. Run and Pre-run. Press the
PRERUN button to check the protocol before operation. Press the RUN button to

execute a protocol.
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6.6.1 Pre-run aprotocol.

. . ”
Before running the protocol, simulate the whole process. Press = &« button,

then select the options in Prerun Method.
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® Run All Command: to carry out the simulation step by step.

® Run Partial: to carry out the selected specific commands that from drop-down
menu.

® Show Result Only: the worktable displays results after executing al
commands.

® Speed: varies the simulation speed by moving the speed bar.

6.6.2 Run a protocol

After setting all commands of the protocol, press %  putton in the bottom of

the main (in Step 3 Run section) to start arun.
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A checklist window will appear after the protocol is saved. Please ensure the
following:

# Correct tubes, plate and tips types have been selected.

#® All tubes, plates and tips are in their correct locations.

® The required tips are selected.
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® Enough buffer, diluent, reagents, samples have been provided. (All required
volumes of Source wellswill be shown in Detall.)
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7 Maintenance

7. Maintenance

EzMate 401/601 is a robust, reliable instrument that requires minima maintenance. Its
enclosure protects it from dust and foreign objects, thus its motion control components,
such as linear guide, belt and motor, require almost no maintenance.

The rest of the components, such as APM, Adapters, worktable can be cleaned,
disinfected or serviced as described in the sections below.

Caution!
UV radiation will damage the exposed cables, APM and motion control parts.

7.1 Cleaning the Worktable

Use a soft, lint-free cloth and mild detergents, such as 5% bleach, or 70% ethanol to
clean the worktable.

7.2 Cleaning the Automated Pipetting M odule (APM)

The housing of APM module is made of ABS plastic material. To clean the APM,
remove the APM from the Z-axis platform first. Use a soft, lint-free cloth and mild
detergents, such as 5% bleach, or 70% ethanol to clean the APM.

Caution!
APM can’t be autoclaved.

7.3Servicing the Automated Pipetting Module
(APM)

To maintain the Accuracy and Precision, such as the hand-held manual or electronic
pipettes, return the APM to Arise or its service partners for annual calibration service.
The fuse is located in the power socket module, just below the power connector.
Replace the fuse if the unit does not turn on when the power switch isturned on.
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7.4 Cleaning the Adapters

Use a soft, lint-free cloth and mild detergents, such as 5% bleach, or 70% ethanol to
clean the surface of Adapters. The Adapters, except the CoolBlocks, can be
autoclaved for 20 minutes at 121 € and 1 bar pressure.

7.5 Replacing a Fuse

The fuse is located in the power socket module, just below the power connector. If

the unit does not turn on when the power switch is turned on, then replace the fuse.

To replace the fuse:

1. Disconnect the power cord from the unit.

2. Remove the fuse drawer with a small-blade screwdriver.

3. Pull the fuse out of the fuse socket and replace the fuse with the correct current
rating: 3.5A, 5x 20mm, Glass Tube.

4. Reinsert the fuse into the fuse socket and the fuse drawer.
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8 Troubleshooting

8. Troubleshooting

Problem Cause Action
Power failure. Blown fuse. Replace anew fuse.
Droplets left inside the tip.  [Unsuitable tip. Use Beckman Biomek® 3000

compatible tips.

Leakage or volume too small.

Worn-out internal O-ring.

Replace the defect internal
O-ring with anew one.

Failure to aspirate.

The lower manifold is not
correctly attached.

Detach and reassemble

Foreign material blocking the
hole at bottom of the cone.

Use MIX mode and distilled
water to wash.

Piston movement is blocked.

Lubricate piston.

8.1 Error Messages

Code |Message Cause Remedy
L Original protocol file has i )
1001 |[Not an existing file!! Check file location.
been deleted or moved.
Is stem  storage ace
0001 |System Initial Error Initial APS system failure ¥ e P
enough?
Not a APS protocol format
1002 file P File damaged. Check protocaol file format.
Protocol has the wrong/Change APM module or
Protocol has wrong APM _ _
0002 dection!! selection  with  connectedirecreate a new protocol for
h APM module. current APM module.
2001 Connection  time  out|No connection /w APS when|Check USB/RS-232 connection
error!! protocol is running. cable.
APM NOT(Wrong APM module during _
0003 L Check APM's seria number.
AVAILABLE!! software calibration.
No connection /w APS when|Check USB/RS-232 connection
0004 |APSNOT AVAILABLE! o
system isinitialized. cable or reset APS.
. _ Microplate layout cannot do .
2002 |Loop Submission Failure!! ) Check microplate layout.
loop function
Printing Error!! Check|PC has no connection /w ) )
9901 _ _ Check printer connection.
Printer. printer.
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Appendix A : Recommended Consumables

The consumables in the list below are tested and recommended for EzMate 401/601 by
Arise Biotech. Other consumables can be used on EzMate 401/601 as well, as long as
distributors have defined their Calibration file before usage.

Description Vendor Catalog Capacity Dead Type
Number | Volume(ul) [Volume(ul)

96-well Plates
FrameStar 96, Red 4titude 4ti-0730/R 200 10 Half-Skirted
Frame, Natural wells
FrameStar 96, Blue  |4titude 4ti-0960/B 100 10 Full-Skirted
Frame, Clear Wells
FrameStar 480,96 well |4titude 4ti-0951 100 10 Half-Skirted
Semi skirted,Clear
Frame
FrameStar 96, Clear  |4titude 4ti-0900/C 200 10 Half-Skirted
Frame, Natural wells
0.2ml 96 well plate |ABgene |AB1100 200 10 Half-Skirted
96 Well MicroAmp®  |ABI N8010560 200 10 Half-Skirted
PCR Plate
96 Well MicroAmp®  |ABI 4346907 100 10 Half-Skirted
Fast PCR Plate
96 Well Half Area, Costar 3695 100 Full-Skirted
Flat Bottom,
Non-Treated (ELISA)
96 Well, Flat Bottom |Costar 9017 200 Full-Skirted
(ELISA)
LightCycler® 480 Roche 047729692001|100 10 Half-Skirted
Multiwell Plates 96,
Half-skirt
96 Well PCR Plate, Sarstedt  |72.1979.202 |300 10 Half-Skirted
Half-skirt
96-Well PCR Plates |Labcon  [3977-520 200 10 Non-Skirted
96-Well PCR Plates |Labcon  [3972-520 200 10 Half-Skirted
0.2ml 96 well plate  |Protech  |SP-0446 200 10 Half-Skirted
1.2 mL Deep Well Sarstedt  |82.1970.002 |1200 30 Deep-Well
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Plate (Round)

0.2ml 96 Well Plate  |SSI 3450-00 200 10 Half-Skirted

384-well Plates

FrameStar 384, Purple |4titude 4ti-0384 20 Full-Skirted

Frame, Clear wells

384 Well MicroAmp® |ABI 4309849 30 Full-Skirted

PCR Plate

LightCycler® 480 Roche 047729749001|20 Full-Skirted

Multiwell Plates 384

384 Well PCR Plate  |Labcon  [3983-520 25 Full-Skirted

8-strip PCR Tubes

0.2ml 8 well strip Biomate |PTN40-02 200 10 Non-Skirted

0.2mL 8-Strip ABI 4316567 200 10 Non-Skirted

0.2mL 8-Strip Labcon  [3940-550 200 10 Non-Skirted

Micro Tubes

Micro Tube 1.5 ml Axygen |MCT-150-C [1500 20

Micro Tube 2.0 ml Axygen |[MCT-200-C (2000 20

Micro Tube 1.5 ml Sarstedt  |72.692.005  |1500 20

Micro Tube 1.5 ml Sarstedt  |72.690.001  |1500 20

Micro Tube 2.0 ml Sarstedt  |72.694.006  |2000 20

Micro Tube 1.5 ml SS| 23400-00-R2 (1500 20

1.7 mL SuperClear Labcon  [3012-870 1700 20

Tubes

Safe-Lock Tube 1.5 ml |Eppendorf (0030 120.086 [1500 20

Bottle

Narrow-Mouth Bottle |Nalgene |2006-9025 5000 1200

PP, 8mL

Tips

50ul w/o filter, EzZTip T0O0-ezar00-00|50 Non-filtered

Non-Sterile

200ul w/o filter, EzTip T00-ezar01-00|200 Non-filtered

Non-Sterile

50ul w/o filter, Sterile |EzTip T00-ezar02-00|50 Non-filtered,
Sterile

200ul w/o filter, EzTip T00-ezar03-00|200 Non-filtered,

Sterile Sterile

50ul w/o filter, Beckman |A21578 50 Non-filtered
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Non-Sterile

200l wio filter, Beckman (717251 200 Non-filtered

Non-Sterile

50ul, Filtered, Sterile  |Beckman |A21586 50 Filtered,
Sterile

125ul, Filtered, Sterile |Beckman |717253 125 Filtered,
Sterile

50ul w/o filter, Axygen* |FX-50-R 50 Non-filtered

Non-Sterile

200ul wio filter, Axygen* |FX-250-R 200 Non-filtered

Non-Sterile

50ul, Filtered, Sterile  |Axygen* |FXF-50-R-S |50 Filtered,
Sterile

165ul, Filtered, Sterile |Axygen* |FXF-180-R-S |165 Filtered,
Sterile

Notice!

* Since the inner diameters of Axygen Beckman compatible robotic tips are small
than the original Beckman Biomek 3000 tips’, the Axygen Beckman compatible
robotic tips can’t fit the 8-channel APMs well. Please ask Arise’ authorized
distributors for custom-made 8-channel APMs which fit Axygen Beckman
compatible tips well.




Appendix B : Technical specifications

Appendix B : Technical specifications

Worktable Capacity: Area A/B/C, 2 or 3x 96/ 384 SBS PCR plates,
AreaC/D, 2 or 1 x 96 tip rack (50/200 pl),
Reagent Areal: 8x 1.5/2 ml microcentrifuge tube,
Reagent Area2: 6 x 2 ml storage tube (free standing) and 1 x 5 ml
bottle.
Dispensing Function: Liquid (Sample/Reagent) Transfer (LH)
Multiple Dispense (MD)
Serial Dilution (SD)
Hold (Pause)
Mixing (MIX)
Loop
Automated Pipetting Module(APM): Interchangeable 1/8-channel, Maximum volume
50 pl/200 pl.
Connection: RS-232, USB2.0
Power Supply: 100~240V, 50/60 Hz, 100W
Size (W x D x H): 590 x 440 x 460 mm
Weight (N.W.): 25Kg
Operating Temperature*: 15 to 30C
Operating Humidity (R.H.) *: 40 ~ 85%

*Note: Operating Temperature and Operating Humidity are for the operation of EzMate 401/601. To
achieve better accuracy and precision, the operating temperature (21 ~ 25€C +0.5C) and humidity
(60~90%) based on | SO-8655 standards should be followed.

Perfor mance of Automated Pipetting Module (APM)

1/8 channel- Volume 50 pl

1pl 50

Accuracy (Rel.) + ™% + 1%

Precision (Rel. CV) [<7.5% |<0.4%
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1/8 channel - Volume 200 pl

10 pl 200 pl
Accuracy (Rel.) +3% [|+£0.8%
Precison (Rel.CV) 1% [<£0.15%

Note: According to SO-8655 standards ( Gravimetic method ), APM is calibrated in temperature (21 ~

25T +0.5C) and humidity (60~90%) controlled environment. Twice-distilled water, robotic tips and
microbal ance were used.
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Appendix C : EzMate 401/601 Sample

Protocols

EzMate 401/601 has four sample protocols for users’ reference. Users can click Open
protocol — User’s document — EzStarter — Protocol Sample File to find the
protocols (4 Series folder for EzMate 401, 6 Series folder for EzMate 601). Open the
protocol whose file name (APM50-1 represents 1-channel, 50l APM) indicates the same
APM was mounted on the APS, and put the correct labwares on the adapters. Then, click
RUN and the APS will run the sample protocol.

3 APS Files Location
@Uv! . « Protocol Sample File » 4 Series v |v'y ! ‘ Search 4 Series » ?
Organize v New folder = v i '@‘

~ .
¢ Favorites — Documents library e .
o i Arrange by: Folder ¥
B Desktop 4 Series
”ﬂ’ Downloads Name Date modified Type Size
! RecentPlaces |_
(3 2] APM50-1 3/1/2012 2:13 PM APS File 236 KB
& APMS0-8 3/1/2012 2:31 PM APS File 236 KB

4 Libraries

&) APM200-1 3/1/2012 2:23 PM APS File
| =] Documents =
B Musi ‘ 2| APM200-8 3/17/2012 2:43 PM APS File
@' Music - —
[ Pictures
E Videos
M Camnuter ¥
File name: v [APS files (*.aps) v]

I Open iq [ Cancel ]

87



EzMate™ 401/601 Automated Pipetting System

Appendix D : CE Declaration

C€

Arise Biotech Corp.

3 F, No. 5, Alley 2, Sih-wei Lane, Jhong-jheng Rd,
Sin-dian District, New Taipel City,

Taiwan, R.O.C.

Declaration of Conformity

Product Name: EzMate™ 401 Automated Pipetting System

Model Names; EzMate™ 401

All models comply with the following European standards:

EMC: EN 61010-1, EN 61010-2-81

Safety: EN 55011/B, EN 61000-6-1, EN 61000-3-2/3, EN 61000-4-14,
EN 61326-2-6

To the best of my knowledge and belief, these units conform to these
standards.

_]:y Lo

Name: Jerry Liao

Position: Quality Assurance Manager
Issue Date: 2011/5/30
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Appendix E : EzSarter Installation and

Uninstallation

For USB connection, except EzStarter, users are required to install the USB driver as well.
The USB driver can be found in the Software DVD ( directory:
SiLabs\CP210xV CPInstaller.exe).

EzSarter Installation

To install the EzMate 401/601 Software-EzStarter, please insert the EzMate 401/601
Software DVD into the DVD Driver of the computer and start the installation
process by running the setup.exe file. Please follow these steps set up EzStarter.

Step 1- Welcometo the EzStarter Setup Wizard

The installation wizard will guide users through the installation process. Selecting
will take users to the next screen.

ﬁj‘(:‘,’umr | s

Walcome to the EzStarter Setup Wizard

Tz inekadber vl Quecke pou hough te cteps regqueed Lo matal £25 1 arder o powr compuiet

WRANNG: The conpue o iam & podectad by Copamg il bas &'d ieamaion & Yastied
Unedoreed dupleabon o datnbdbon ol thee progun, o anyy portienicl §, may wzdin sevae ol
or om i penaleg, and vl e no cecubed o e nasmm sl porible inces B ey

Coarced | News

Step 2- Select Installation Folder
This step allows users to select the folder into which they want the software to be

installed. The button enables users to locate specific folders. Selecting
will take users to the next screen.
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Select instaliation Folder %

Thainstalarmtinetsl ExStater 1o e bodowngfoldsr
To nctalin b fddhe, chc "Wed" Tu irdtal lo o d¥ererd fokder, arber 1 bekay or chick "Srovee’’

Fakder
[C\Pro rars Fiscd Ao St Browse..

Diak Cout.

Coance < Back, | Net) |

Step 3-Confirm installation
Select to start the software installation procedure. Select to exit the
setup.

Didie FE

Confirm Instaliation &

The mdabes o weady 1o nmilal E251ater on yous conpaer,
Ok ' Neal* 1o st theiressbaion

] (] [aeen
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Step 4- Installing EzStarter

Q‘ EzSearter
Installing EzStarter

EaStaba b baarg nvalled

Flaace mat

Step 5- Installation Complete
Select to end the software installation procedure and close the setup

program.

_‘;@ ExStarter

Installation Complete

Ez5tarter has been successfully installed.

Click "Close" to exit,

Please use Windows Update to check for any critical updates to the MET Framework.

Cancel < Back Cloze
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EzSarter Uninstallation

To completely remove the EzMate 401/601 Software-EzStarter, please select
‘Control Panel\Programs\Uninstall a program’ and select the EzStarter from the

menu.
i@
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Appendix F : Ordering Information

Users are required to purchase the USB or RS-232 cable to connect the EzMate 401/601
and the PC. For USB connection, users are required to install the USB driver.

Catalog no. Description
EzMate™ 401

4-position Automated Pipetting System,

AREZ401-10000
15.6" Notebook Computer and EzStarter™ control software

EzMate™ 601

6-position Automated Pipetting System,

AREZ601-10000
15.6" Notebook Computer and EzStarter™ control software

EzMate™ 401s

4-position Automated Pipetting System with UV / HEPA,

15.6" Notebook Computer and EzStarter™ control software
4-position Automated Pipetting System with UV / HEPA and
EZASUAO0-100000 |2-position Active Cooling / Heating module,

15.6" Notebook Computer and EzStarter™ control software
4-position Automated Pipetting System with UV / HEPA and
EZASUAC-100000 |3-position Active Cooling / Heating module,

15.6" Notebook Computer and EzStarter™ control software

EZ4SU00-100000

EzMate™ 601s

6-position Automated Pipetting System with UV / HEPA,

15.6" Notebook Computer and EzStarter™ control software
6-position Automated Pipetting System with UV / HEPA and
EZ6SUAO0-100000 |2-position Active Cooling / Heating module,

15.6" Notebook Computer and EzStarter™ control software
6-position Automated Pipetting System with UV / HEPA and
EZ6SUAC-100000 |3-position Active Cooling / Heating module,

15.6" Notebook Computer and EzStarter™ control software
Interchangeable Automated Pipetting Modules

EZ6SU00-100000

275-ezar01-00 1-channel, 50 pl Pipetting Module
275-ezar02-00 8-channel, 50 pl Pipetting Module
275-ezar03-00 1-channel, 200 ul Pipetting Module
275-ezar04-00 8-channel, 200 ul Pipetting Module
275-ezar04-10 8-channel, 200 pl Pipetting Module for Axygen
Roboatic Tips

T0O0-ezar00-00 EzTip™ 50 pl, non-sterile, 96 tips/rack; 10 racks/pack
T0O-ezar01-00 EzTip™ 200 ul, non-sterile, 96 tips/rack; 10 racks/pack
T00-ezar02-00 EzTip™ 50 pl, sterile, 96 tips/rack; 10 racks/pack
T00-ezar03-00 EzTip™ 200 pl, sterile, 96 tips/rack; 10 racks/pack
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Catalog no. Description

Accessories

275-ezar21-00 96 tips rack adapter

275-ezar22-00 Elevated 96-well PCR plate adapter

275-ezar23-00 Elevated 384-well PCR plate adapter

275-ezar24-00 Deep well plate adapter

275-ezar26-00 4 x 2 1.5/2 ml tubes adapter

275-ezar27-00 3 x 22 ml storage tubesand 1 x 5 ml bottle adapter

275-ezar30-00 CoolBlock™ 96 adapter for 96-well PCR plates

275-ezar31-00 CoolBlock™ 384 adapter for 384-well PCR plates

275-ezar34-00 CoolBlock™ R10 adapter for 4 x 2 1.5/2 ml tubes

975-e78r35-00 CoolBlock™ R20 adapter for 3 x 2 2 ml storage tubes and 1 x 5ml
bottle

275-ezar37-00 CoolBlock™ 20-well adapter for 1.5/2 ml tube

275-ezar40-00 Elevated 20-well 1.5/2 ml tube adapter

275-ezar47-00 Reservoir adapter

275-ezar49-00 Disposable 80ml reservoir x 20 pcs

275-ezar51-00 Disposable used tip tray x 10 sets

275-ezar66-00 HLA typing adapter for 60/72 well

275-ezar67-00 HLA typing adapter for 96 well

275-ezar68-00 0.5ml tube adapter for 20 well adapter

275-ezar72-00 3 x 15ml reservoirs adapter

275-ezar73-00 Disposable 15ml reservoir x 9 pcs

275-ezar74-00 3 X 8-strip tubes adapter

275-ezar76-00 Elevated ELISA / cell culture adapter

275-ezar78-00 [llumina 48-well plate adapter

275-ezar79-00 R1 Active Cooling / Heating Adapter

275-ezar80-00 R2 Active Cooling / Heating Adapter

275-ezar81-00 96-well PCR plate Active Cooling / Heating Adapter

275-ezar82-00 384-well PCR plate Active Cooling / Heating Adapter
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